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Preface: The Herschel Observation
Planning Software (HSpot), Expert
User Version
1. A note about this revision

At the time that this manual was conceived, Expert HSpot was newly available and its use in Opera-
tions was still an unknown quantity, hence it was felt useful to have the manual available as a guide
to the extra features of Expert HSpot. As it turned out, the use of Expert HSpot was limited to a very
small number of genuinely expert users, so a manual was actually found to be unnecessary and so
the manual was not maintained after the initial, draft version. In post-Operations, many of the people
who used Expert HSpot have started to leave the project and new people are being recruited. Lack of
habitual use of Expert HSpot means that some of the details of use that were second nature to users
during Operations are now being forgotten and it is, again, useful to have a repository for this in-
formation, hence this post-Operations update.

The aim is not to have an exhaustive guide to Expert HSpot, but instead to detail some of the func-
tions that are still of interest to expert users at HSC and in the ICCs.

2. Purpose of this Document
This manual is intended to be an aide memoire for users of Expert HSpot, to remind them of how
the most important functionalities of Expert HSpot worked, in particular, how to configure it.

Expert HSpot is the extended version of the HSpot observation planning software the means by
which users and potential users of the Herschel Space Observatory can provide new and updated ob-
serving requests for the observatory.

Expert HSpot is designed to be used only by a small group of users in the Instrument Control
Centres (ICCs) and at the Herschel Science Centre (HSC) who have needed to prepare and to pro-
cess calibration observations, engineering observations (SEU checks, cooler re-cycles, etc) and the
special observations in non-standard observing modes that have been required through the mission
and in the post-cryo phase. It is not and was not intended that normal Herschel users should use Ex-
pert HSpot, or necessarily even be aware of its existence and capabilities.

Expert HSpot also incorporates all the features of standard HSpot, plus extra options in the proposal
submission tool allowing authorised users to submit calibration proposals. It is a further, extra layer
added to HSpot, which has been developed specifically for Herschel. HSpot itself is based on Spot
(originally SPOT - SPitzer Observing Planning tool) developed for NASA's Spitzer Space Tele-
scope, which forms the core of HSpot (i.e. the "Spot Core"). It is a layer that includes many Her-
schel-specific upgrades, particularly the capability to deal with spectroscopic observations, which is
not available in the Spot Core and was designed for the formulation of observing requests for the
three science instruments on board Herschel -- HIFI, SPIRE and PACS. Detailed information on the
instruments, and some further, instrument specific, Expert HSpot illustrations are provided in the
three instrument manuals also available from the Herschel Space Observatory website at:

http://herschel.esac.esa.int/

For help that is not provided in either the instrument or Expert HSpot manuals, the Herschel Help-
desk can be contacted at:

http://herschel.esac.esa.int/esupport/

Helpdesk has a web interface only. Users are not be able to send questions by email. To submit a
question a user must register with Helpdesk (http://herschel.esac.esa.int/registration.shtml) as, only
by registering, will the user be able to supply all the contact details that we need to respond to quer-
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ies.

The prime purpose of this manual is therefore to describe the setup and use of the user interface to
Expert HSpot.

3. What this Document Does Not Provide
Many of the options offered by Expert HSpot are identical to those of standard HSpot: for details of
the common functionality see the HSpot User Manual. This User Guide concentrates on the areas
where Expert HSpot and HSpot have differences: common functionality is only detailed where there
are significant differences in a related process step.

This manual provides information on the user interface for Expert HSpot only, and does not attempt
to describe more fully the transformation to uplinked spacecraft/instrument commands which are
written in the Common Uplink System (CUS) language.

Information on the data products, pipeline processing and data processing (included in the Herschel
Common Science System, HCSS) is also not covered in this manual. Processing and products in-
formation is available in the documentation on downlink available from the Herschel web site at

http://herschel.esac.esa.int/

4. How to use this manual
Many users will find that, once Expert HSpot is installed, they can start to use it with little or no dif-
ficulty without recourse to documentation. Such users will find that this manual, in conjunction with
the standard HSpot User Guide are a useful aid to consult where they have doubts about a particular
function of Expert HSpot and how it works. For those users who feel less confident, there is no need
to read either manual from cover to cover: concentrate on the chapters relevant to your own proposal
with the aid of the chapter guide. Use these manuals more as a reference source to check detailed
points about Expert HSpot use, rather than as must-read documents.

5. Differences between Expert HSpot ver-
sions on different platforms

The screenshots presented here are from the Linux version of Expert HSpot. Users will find that the
appearance of the different screens will be subtly different with, for example, pop-ups appearing
with slightly different style or colours on the different operating systems that run Expert HSpot. Oc-
casionally, in some user dialogues, the MAC version of Expert HSpot may have the same buttons,
but in a different order to the Windows and Linux versions; we have also noticed that the handling
of tabbing in pop-up windows is slightly different. Although the flavour of Expert HSpot is slightly
different on each operating system, the functionality is the same.

Warning
There are a few platform-dependent bugs due to problems with Java or window managers. These
bugs are reported to the relevant company, but we cannot always guarantee that they will be fixed
as they are out of our control. The level of user-support offered by external software suppliers is
highly variable.

6. A disclaimer
Expert HSpot is an evolving system. Every effort has been made to ensure that the screenshots and
description in this document are completely up to date, however there may be some cases where
new functionality has been added that has not been completely documented, or could be better docu-
mented. If you find an example of incomplete or out-of-date documentation of a function, please
contact Helpdesk http://herschel.esac.esa.int/esupport/, with a description of the problem, or a sug-
gestion about how the documentation can be improved.
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Chapter 1. Introduction to Expert
HSpot
1.1. Some notes on Expert HSpot

Welcome to Expert HSpot, the advanced tool for planning Herschel observations and submitting
proposals. The Expert HSpot software is incorporated into each standard HSpot release, forming a
hidden layer that normal HSpot users do not see. HSpot is available to download from the Key
Project Announcement of Opportunity page at the Herschel Science Centre (HSC) web site (ht-
tp://herschel.esac.esa.int/).

This User's Guide provides information about how the Expert HSpot software works. The Release
Notes that are packaged with the software provide additional information about computer platforms
supported for this version, performance issues, and a list of known bugs, although bugs are generally
fixed rapidly when reported. It has been assumed that the user has read, or is at least familiar with
the relevant sections of the Herschel Instrument and Observatory Manuals (available on the HSC
website at http://herschel.esac.esa.int/) when deciding how best to implement their observations.

1.2. Some background information
Expert HSpot is a mixture of what is termed "core Spot", which is hardwired into Expert HSpot and
maintained by the Spitzer staff at IPAC and Herschel-specific functionality maintained by Herschel
staff.

A list of core Spot bugs can be found at the Spot public bug list page.

A list of Expert HSpot bugs can be found on the Herschel AO page Herschel web page.

If possible, use one of the officially acceptance tested versions of Expert HSpot on a standard oper-
ating system/platform combination. Although every effort is made to support a wide range of plat-
forms and operating systems, Expert HSpot is a highly complex piece of software and no guarantees
can be offered that all the new functionality that has been added for Herschel's instruments will
work with all the older versions of the operating systems offered.

Save your AORs often. Expert HSpot does not save your work to disk automatically. Although
HSpot has proved to be remarkably robust and trouble-free, given the variety of operating systems
we support, we cannot guarantee that it will never crash on your particular computer and operating
system. Saving your work often will make these events much less painful should they happen.

Please contact us at the Herschel Help Desk (http://herschel.esac.esa.int/esupport/) with any ques-
tions (for technical reasons there is only a Web interface to Helpdesk).
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Chapter 2. Installing and configuring
Expert HSpot
2.1. Overview

Expert HSpot requires individualised installation according to where it is installed and run and to be
linked to the JBOSS server that your institution is running. If you are working at an Instrument Con-
trol Centre (ICC) your system manager will have done the necessary system configuration for you.
If you are working at the HSC, Expert HSpot will be automatically configured to work with the
HSC's dedicated JBOSS server.

2.2. Who needs to use Expert HSpot?
Normal users of Herschel will use the standard HSpot set-up; they have no requirement to use the
specialist applications of Expert HSpot. The main functions of Expert HSpot is to prepare and sub-
mit the specialist observations required to test and check-out the Herschel instruments in the com-
missioning and Performance Verification phases of the mission and for preparation of the calibra-
tion and house-keeping observations that will ensure that astronomers can calibrate and use their
data throughout the entire mission.

Expert HSpot was thus intended principally to be used by Instrument Calibration Scientists, both
working at the ICCs from which each of the Herschel instruments is controlled and at the HSC.

However, it was also found that other features of Expert HSpot are of great use to Community Sup-
port Scientists at HSC, while the processing of calibration deliveries at HSC required of itself the
use of Expert HSpot. This means that all scientists at HSC are potential users of Expert HSpotas
well as many of the engineers and the scientists at the ICCs.

2.3. How do I get to see Expert HSpot
To get to see the extra functionality of Expert HSpot you need to carry out the following steps:

• Go to the ".spotherschel" directory on your computer. This is a system directory where the
HSpot configuration files are stored. You may need to make system directories visible on your
computer to be able to do this.

Note

Where is the .spotherschel directory on my computer?

This directory is created the first time that you start up HSpot on your computer.

In Windows: Reveal hidden files and folders by going to the "Tools", "Folder Options" menu in
Windows Explorer and selecting the "View" tab. Select the "Show hidden files and folders" option.

In Windows XP the directory is in C:\Documents and Settings\username\Application Data

In Windows 7, it is in c:\Users\username\AppData\Roaming\spotherschel

In Unix and Linux, it is in ~/.spotherschel

• Open the "user-preferences.prop" file in an editor.

• Insert the line "calibration.mode.Selected=true", as shown in Figure 2.1 and save the modified
file to make the change effective.

• Start up HSpot as usual.
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Figure 2.1. The "user-preferences.props" file showing the additional line that must be added, circled in
red, to make Expert HSpot visible.

When HSpot starts up you should see the following initial screen, as shown in Figure 2.2

Installing and configuring Expert HSpot
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Figure 2.2. The initial screen of Expert HSpot when it is started up.

Note that an additional drop-down menu labelled "Calibration" appears between "Tools" and "Im-
ages".

2.4. Setting-up of Expert HSpot for ICCs
2.4.1. Additional set-up of Expert HSpot for ICCs

When running Expert HSpot from an ICC you will almost certainly wish to configure your installa-
tion for a particular instrument or mission configuration and for it to connect to your local server,
otherwise you will automatically connect to the HSC JBOSS server.

To connect to your local JBOSS (each ICC has a JBOSS server installed), you need to add the fol-
lowing lines to your "user-preferences.prop" file. Your System Administrator will tell you what val-
ues to insert:

• herschel.serverHost=

• herschel.serverPort=

• herschel.worker=

You can check that you are connected to the correct JBOSS and that your configuration is correct by
looking at the "Help" drop-down menu and selecting "About", as shown in Figure 2.3

Installing and configuring Expert HSpot
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Figure 2.3. The "Help" drop-down menu in the initial screen of Expert HSpot.

Clicking on "About" will bring up the pop-up shown in Figure 2.4 that shows all the parameters that
are defined. The three circled lines show the Host, the Port and Database to which you are connec-
ted. These should correspond to the values that your system administrator gave you.

Installing and configuring Expert HSpot
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Figure 2.4. The "About" pop-up, which shows you the current configuration of Expert HSpot. This en-
ables you to check that you are connected to the correct JBOSS server and database.

Warning

HSpot re-writes your .prop file with your latest configuration and directories used each time that
you exit a session. This means that even if you wrote the extra lines of configuration at the end of
the file to make finding them later easier, they will almost certainly have been moved in the file
when you next open it to edit it.

Don't panic! Use the search function to find the term(s) that you need to edit.

2.4.2. Deconfiguring Expert HSpot
Once you have installed Expert HSpot you may wish, for some reason, to disable it. You should also
be aware that, once configured to connect to your local JBOSS server, you will not be submit pro-
posals to a Call for Proposals without deconfiguring so that, once again, you link to the HSC Opera-
tional JBOSS Server.

To disable Expert HSpot edit your "user-preferences.prop" file and change "calibra-
tion.mode.Selected=true" to:

• calibration.mode.Selected=false

Alternatively, you may comment out the line:

• #calibration.mode.Selected=true

Or, simply erase the line.

Of course, after changing, you must save the changes in the preferences file and restart HSpot to
make the changes effective.

To connect to the HSC Operational JBOSS Server instead of your local JBOSS, so that you can sub-
mit a proposal to respond to a Call for Proposals, you need to comment out the following lines that
you added to your "user-preferences.prop" file in the following way, by the addition of the leading
hash mark, as shown:

• #herschel.serverHost=

• #herschel.serverPort=

• #herschel.worker=

Of course, you can simply erase the lines too, although by commenting out they are available to be
reactivated at any moment, as required. Save the changes and restart HSpot to make them effective.

2.4.3. Additional set-up of Expert Expert HSpot for
Community Support Group users

There are various Expert HSpot options of particular use and interest to Community Support Group
members in carrying out their functional tasks, such as updating proposals for scheduling, cloning
engineering AORs, or updating proposals to the latest Mission Configuration software.

Installing and configuring Expert HSpot
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2.4.3.1. Setting up Expert HSpot to see different databases

To set up Expert HSpot to see a different database, edit your "user-preferences.prop" file and modi-
fy the line:

herschel.worker=

To the value appropriate for the database that you want to access.

• herschel.worker=herschel_phs (to see the Astronomer database -- the latest version of the pro-
posal as the Astronomer has submitted it)

• herschel.worker=herschel_phs_test2 (to see the Operational database -- the latest version of the
proposal as submitted for scheduling to the Mission Planners)

• herschel.worker=herschel_phs_test3 (to see the Staging/test database -- used for testing purposes
only, such as preparing experimental telescope schedules to examine alternative scheduling solu-
tions, acceptance testing, etc.)

2.4.3.2. Setting up Expert HSpot for proposal handling

To set up Expert HSpot for the special propHandler option that allows you to update proposals for
any user in the Operational database, edit your "user-preferences.prop" file and add the line:

prophandler.mode.Selected=true

You will see an extra option in the Proposal Submission Tool window called "PropHandler" (see
Figure 2.5 ). To use it you must have been granted the appropriate Proposal Handler privileges by
your system administrator. See Section 5.1.2 to learn more.

Figure 2.5. The "propHandler" option and its drop-down menu in the Proposal Submission Tool of Ex-
pert HSpot.

Installing and configuring Expert HSpot
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Chapter 3. The Calibration Menu
3.1. Setting up your observing modes

To be able to generate calibration proposals you need to have loaded a series of required observing
modes into Expert HSpot. Each Mission Configuration used during Operations came with its associ-
ated generic AOTs. The number of generic AOTs could vary between an Astronomer Mission Con-
figuration (used for scheduling science observations) and the Calibration Mission Configuration (in
which special non-astronomer modes might be required for specific calibration or engineering
tasks). In general, the number of generic AOTs increased during the mission as extra options were
defined, before stabilising later in operations.

Figure 3.1. The initial calibration menu to read in the required properties files.

The final Astronomer Mission Configuration (MC_H102ASTR_P70ASTR_S66ASTR_RP-120713)
used during Operations -- there were numerous later Mission Configurations that were used for cal-
ibration and engineering observations, or delivered as a contingency in case HIFI declared a laser-
comb failure) -- has 64 HIFI generic AOTs, 262 generic PACS AOTs and 80 SPIRE generic AOTs.
You can compare these numbers with the initial, pre-flight total of 54 generic AOTs, of which 40
were for HIFI. The required properties files must have been previously generated using the pro-
pHandler program, which is a part of the Proposal Handling System (PHS) external to HSpot. These
properties files are generated for a particular Mission Configuration using a set of CUS files and
Calibration Tables that have previously been linked in the local JBOSS server: each ICC will have
defined its own particular system for doing this.

Each properties file (.prop) reads the CUS script and writes code that Expert HSpot uses to generate
the HSpot front end. Each time that new CUS scripts are introduced, propHandler must be used to
make them available to Expert HSpot and they must be copied to the JBOSS.
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3.2. A brief description of the generic AOTs
The observing modes are a mixture of engineering observations, calibration observations and non-
standard AOTs. As there were so many modes and the generic AOTs changed so much through Op-
erations that it makes little sense to include a detailed description of them here. Some modes were
just introduced for single, specific tests early in the mission others, as we will see in Section 3.4
were used on a daily basis.

When you look at the generic AOTs, you will see that they are divided by instrument and sub-mode
into 13 distinct groups, as shown in Figure 3.2. Within each group of Generic AOTs there may be
many individual AOTs, sometimes many tens, as shown in Figure 3.2. The groups are arranged by
generic type, with each individual AOT assigned to one of the individual groups according to it
function.

• For HIFI: HifiEng (engineering AORs only, e.g. SEU checking), HifiPoint, HifiMap and HifiS-
Scan, these last three groups being specialist, non-astronomer observing modes associated with
the three HIFI AOTs.

• For PACS: PacsCal (calibration AORs only), PacsEng (engineering AORs, e.g. cooler re-
cyclings), PacsLine, PacsPhoto and PacsRange (specialist, non-astronomer AORs associated
with the three PACS AOTs).

• For SPIRE: SpireEng (engineering AORs), SpirePacs (for Parallel Mode), SpirePhoto and Spire-
Spec (specialist, non-astronomer AORs associated with the three SPIRE AOTs)

Figure 3.2. The division of available Generic AOTs by group.

The Calibration Menu
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Figure 3.3. Detail of one of the groups of Generic AOTs.

3.3. Loading the properties files
To be able to use generic AOTs, which are essential in any day of observing, as these AORs switch
on an switch off instruments and bands, check the health of the different instruments and set up the
instrument correctly for science observations, you must first read in the properties files to make
them available to Expert HSpot. To read in the properties files with the observing modes, you
should choose the "Calibration" menu in Expert HSpot, as shown in Figure 3.1

Click on "Manage Generic AOTs" and a listing of the available properties files will appear, as
shown in Figure 3.4

Expert HSpot allows you to load all the generic properties files that are available. This is the default
option, as shown in Figure 3.4. If you are running Expert HSpot at an ICC probably you will only
wish to load the generic properties file for your particular instrument. In this case you should choose
the "Uncheck all" button and then select the required properties files by hand. You can toggle the se-
lection, or deselection, of all the generic properties files by selecting the "Check All" and "Uncheck
All" buttons.

If you select the "Download prop files from the server" button the list of available properties files
will be updated from the server and any additional files that have been added to the server will be
made available for loading. After using this option, all the available files will be ticked to show that
they are selected for loading, whatever their previous status was.

Select the properties files that you need and press "load Generic AOTs". The files will be loaded in-
to your session of HSpot and a pop-up will appear with confirmation, as shown in Figure 3.5

The Calibration Menu
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Figure 3.4. The listing of available properties files.

The Calibration Menu
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Figure 3.5. Loading of the selected properties files into your Expert HSpot session.

3.4. A practical example: OD-1446
OD-1446 was the final OD of science to be executed, with the temperature rise due to end-of-helium
occurring towards the end of this OD. The schedule for OD-1446 is to be found on the HSC Twiki
at: http://herschel.esac.esa.int/twiki/pub/HSC/HSCMissionPlanningRPAttach/1446_0002.html.

OD-1446 was the last day of a PACS block, in which the first part of the OD was dedicated to HIFI
observations while the PACS spectrometer stayed switched on, but inactive. This means that the OD
effectively started the previous day when the HIFI lasers were switched on and given 24 hours to
stabilise. In Figure 3.6 we see three AORs labelled "Calibration_pv" -- the first is the check for
SPIRE SEUs, the second sets HIFI as the primary instrument for the observing block and the third
switches on and sets up the local oscillator for HIFI Band 7b, ready to observe. All three are No
Pointing AORs (i.e. no pointing commands are generated on the Mission Time Line) and their total
execution time is almost an hour; this is the overhead required to prepare Herschel for observing --
when in Parallel Mode, for example, the set-up overhead imposed by a parallel cooler re-cycle is al-
most 3 hours (the AOR duration is 10352s + the time required to execute any additional set-up
AORs that may be required).

Two integrations are made on a science target in Band 7b then, as we see in Figure 3.7, we switch to
Band 6a to carry out two calibration observations from the HIFI calibration programme for Schedule
Cycle 90. The final HIFI observation commands the instrument into Dissipative II mode, which is
the instrument in stand-by and the lasers on (in Dissipative I the instrument is in standby and the
lasers are switched off, so the instrument is, effectively completely dormant), with the instrument

The Calibration Menu
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set-up for observing later in Band 3b.

We then switch to PACS spectroscopy -- the instrument has been left switched on and set up the
previous day, so no additional set-up is required. We do a science observation on a target, two calib-
ration observations on Neptune in a standard science mode (Calibration_rppacs label) and then three
more integrations on another science target, before running a PACS orbit epilogue ("orbitepi") to
shutdown and make safe PACS; this command also executes various clean-up tasks to ensure that
the instrument is left in a nominal condition. PACS would, in normal circumstances, have resumed
observing two days later, with a full switch-on.

We now resume observing with HIFI in Band 3b, setting up the instrument and switching-on the
local oscillator for Band 3b. Observing continues with HIFI until the end of the OD.

Figure 3.6. The observing schedule for the start of OD-1446, with the engineering observations required
to set up the observation for the OD. This was the final day of executed science before End-of-helium.

Figure 3.7. Continuation of the observing schedule for the start of OD-1446, with the engineering obser-
vations required to set up the observation for the OD. This was the final day of executed science before
End-of-helium.

We can see a good example of just how often some of these engineering AORs were executed dur-

The Calibration Menu
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ing flight Operations in Figure 3.7. The AOR "HifiEngSetIntoPrimary" has suffix "421", meaning
that this is the 421st clone of this particular AOR to have been executed during the mission. For
SEU checks the suffix is even larger.

The Calibration Menu
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Chapter 4. Preparing your AORs
An Astronomical Observing Request (AOR) is a proposed observation with Herschel. It consists of
a target to observe -- in the case of engineering observations this may be null -- and an observing
mode, an Astronomical Observing Template (AOT) tailored for the required observations.

4.1. Defining an observation: the "Targets"
menu: fixed target, SSO and noPoint options

The first step, as in normal astronomical observations, is to define your target(s). This process is es-
sentially identical to normal HSpot, although with one additional option. Select the "Targets" menu
in Expert HSpot, as shown in Figure 4.1

Figure 4.1. The target entry menu in Expert HSpot. Select "New Target" to define your calibration
source.

Now, your course of action will depend on whether you wish to observe a Solar System Object
(SSO), that is, a planet, or an asteroid, to observe a star, or to make an engineering observation.

4.1.1. Using an Solar System Object
Select the "Moving Target" tab in the target entry menu, as shown in Figure 4.2
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Figure 4.2. Entering a moving target in Expert HSpot. Select the "Moving Target" tab to define a Solar
System Object.

Enter the name of your selected target and then press "Resolve to NAIF ID". Expert HSpot will con-
nect to the NASA name resolver software for spacecraft navegation to give you an identification
code for the selected target [for more details on NAIF IDs see the HSpot User Manual and the Her-
schel Observatory Manual].

Figure 4.3. Entering Mars as a calibration target in Expert HSpot. Two NAIF IDs are offered for the
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planet. For all practical purposes for Herschel observations they are identical. Select one of the two and
press "OK".

For a planet, Expert HSpot will offer you two possible options, as shown in the example in Fig-
ure 4.3 for Mars. The single-digit number is the barycentre of the planet plus its satellite system (i.e.
Mars=4, Jupiter=5, etc.), while the three-digit number ending in "99" is the centre of disk. To all in-
tents and purposes the two are identical for observation planning purposes as the mass of any associ-
ated planetary system is too small to shift the barycentre significantly from the centre of the disk. If
you are in any way uncertain, use the disk centre: for Mars, "499".

Figure 4.4. The return when the centre of disk of Mars is specified as the target. The observation will be
identified in HSpot and the Mission planning System with the NAIF ID "499" as its position.

Expert HSpot will come back with the window shown in Figure 4.4. The name of the target and its
NAIF ID will be filled-in in the target entry window. This NAIF ID will then be used by HSpot and
by the Mission Planning System to identify the position of the target for observation. Once the target
NAIF ID is defined you can calculate the visibility and the background as per normal. Press "OK" to
accept the target. This will be you current target and used in all AORs that you define until you se-
lect or define another.

4.1.2. Using a star

Figure 4.5. Entering a fixed target in Expert HSpot. Select the "Fixed Target" tab (the default option) to
define a fixed target (a star, galaxy, AGN, or nebula).

Preparing your AORs
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Again, select the "Targets" menu in Expert HSpot or the bullseye icon underneath the "Edit" menu.
The "Fixed Target" tab should be the default. Enter the name of your calibration source, as shown in
Figure 4.5. If not already selected, choose "SIMBAD" as your name resolver and then press "Re-
solve the Name".

Warning

With bright, nearby stars it is essential to ensure that the "Use Proper Motion" box is checked, as
their proper motion may be significant even on time scales of a few years.

In the case of Arcturus (Alpha Boo), the proper motion is more than 2 arcseconds per year: that is,
by the end of the Herschel mission the true position may be as much as 30 arcseconds away from
the Epoch 2000 reference position.

Accept the target by pressing "OK".

4.1.3. An engineering observation with no target
This uses the "noPoint" generic AOT. In this case a target name is not required.

These AOTs were particularly useful during Operations as, while they were being executed, there
was a guarantee that no pointing commands would be generated on the Mission TimeLine (MTL).
As, frequently, spacecraft engineering activities could only be carried out while the telescope was in
a stable position for a known period of time, these activities were usually scheduled during noPoint
periods, such as cooler re-cyclings.

Figure 4.6. The observation menu showing the list of standard AOTs and then, at the bottom of the list,
the generic AOTs that are available after reading-in the properties files from the JBOSS server. For sim-
plicity just a very small number of all the generic AOT files actually present in the Mission Configura-
tion are shown.
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Figure 4.7. The Expert HSpot front end that appears on selection of the generic AOT for PACS line spec-
troscopy that are available after reading-in the properties files from the JBOSS server.
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4.2. Defining the AOT: The "Observation"
menu

All the properties files that you have loaded into Expert HSpot will become available as AOTs to
define observations, in addition to the standard AOTs that are available through normal HSpot to
define AORs. If you select the "Observation" menu in Expert HSpot, as shown in Figure 4.6

If you select a generic AOT, a pop-up will appear, as shown in Figure 4.7, that allows you to set the
parameters for the AOT and personalise it into an AOR, in exactly the same way as in normal
HSpot.

Figure 4.8. The AOT parameter definition menu for the generic PACS photometry AOT, showing an ex-
ample of changing the parameters, in this case the PACS blue channel filter.
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You should modify the parameters in the pop-up window, as required, as shown in Figure 4.8 and
then press "OK". The parameters are delt with in more detail, instrument by instrument, in the fol-
lowing chapters.

Preparing your AORs
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Chapter 5. Preparing and submitting
Calibration Proposals with Expert
HSpot
5.1. Overview
5.1.1. Introduction

Expert HSpot allows a scientist to prepare and submit a proposal for calibration observations. The
original concept was that these would be observations that would be taken generally in the block of
three hours of each observational day that are reserved for instrument calibration around the Daily
Telecommunications Period (DTCP). It was anticipated that this period of three hours would be a
maximum and that it was possible that on some occasions not all the time would be required, freeing
some additional time during an Operational Day for science observations. In practice, the amount of
time used for calibration reduced considerably though the mission, as familiarity with the instru-
ments increased and the original aims of the calibration programme were met. By the end of the
mission only a small fraction of the theoretical daily three hours was actually being used, allowing
up to 21 hours daily to be used for science observations.

5.1.2. Who can submit a calibration proposal?
To be able to submit a calibration proposal, your role in Herschel database of users needs to be set to
"Calibration Scientist" (as default, when you register as a Herschel user, it is set to "Astronomer",
i.e. a normal user). The role of a user is set by the HSC. If you need to submit a calibration proposal,
but are blocked from doing so by Expert HSpot, you should send a ticket to Helpdesk requesting
that your role be set from "Astronomer" to "Calibration Scientist", giving you the special privileges
that are required to submit calibration proposals. However, save in exceptional circumstances, only
certain staff at the HSC and ICCs will be permitted to submit calibration proposals and no calibra-
tion proposal will be accepted without the approval of the corresponding ICC.

5.1.3. How are calibration proposals treated?
All standard proposals for Herschel observing time must go through a process of refereeing and
HOTAC approval. In contrast, calibration proposals will automatically be set to "Accepted" in the
Proposal Handling System. This means that the AORs in calibration proposals will go straight into
the input stream for the Mission Planning System and will be available to be released, without any
peer review. This is the fundamental reason why the right to submit calibration proposals is tightly
controlled.

Calibration proposals were not ever released for scheduling though without human intervention at
the HSC. Each proposal had to be examined, checked and released for scheduling, by hand, by an
operator at the HSC before the observations can be executed.

5.2. How do I do it?
Essentially, submitting a calibration proposal is just like submitting another Herschel proposal, al-
though simpler, as you do not need to submit a scientific justification (in the Proposal Submission
Tool it was optional, but was subsumed anyway by the delivery note and ReadMe file that was de-
livered with calibration observations, which could be extremely long and detailed in the case of very
extensive or complex observations, where a significant amount of explanation of the aims and meth-
ods was required to ensure their correct execution). To submit a calibration proposal you needed to
prepare at least one valid AOR and a minimal abstract with a summary of your proposed observa-
tions; the Abstract had a maximum extension of 2040 characters, including spaces, but was usually
just a few words.
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5.2.1. AOR preparation
The first step is to prepare your AOR(s), as shown in Chapter 4. Once they are complete and you are
satisfied with them, run the time estimator on all the AORs. The AORs will later be linked to your
proposal. All AORs, highlighted, checked, or not, will be submitted, AS IS, so ensure that only the
ones that you wish to be transmitted remain in your Expert HSpot session. If you have any test
AORs that you were playing with to see the effect of different parameters, junk AORs with funny
names that did not work, or anything else that you do not want executed, erase these additional
AORs before continuing!

5.2.2. The Proposal Submission Tool
Once you have prepared your AOR(s), you should go to the "Tools" menu, as in Figure 5.1 and se-
lect "Proposal Submission Tool" from the drop-down menu.

Figure 5.1. Selecting the Proposal Submission Tool in Expert HSpot. This menu is exactly the same as in
normal HSpot.

Click on "Proposal Type" and you will see an additional option that does not exist in normal HSpot,
the "CAL" option for submitting a calibration proposal Figure 5.2. Select this option from the drop-
down menu to define your submission as a proposal for calibration observations and thus by-pass
the HOTAC process.

Preparing and submitting Calibration Proposals with
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Figure 5.2. Selecting the "Calibration Proposal" option in Expert HSpot. This defines your proposal as
being for calibration observations and thus by-passes the HOTAC process, making the observations
automatically accepted.

When you select "CAL", the proposal submission tool window will change, as shown in Figure 5.3.
Adding the Proposal PDF file and the Science Category of the observations pass from being obliga-
tory to being optional.

Figure 5.3. Selecting the "Calibration Proposal" option in Expert HSpot. This defines your proposal as
being for calibration observations and thus by-passes the HOTAC process, making the observations
automatically accepted.

5.2.3. Cover sheet information
The information in the Proposal Submission Tool window is used to generate the cover sheet of
your proposal. This is simply an executive summary with the basic details of the proposal: who has
submitted; what they wish to do; how much time is required; and a summary of the aims of the ob-
servations. This information is used by the HSC to process and track all observing proposals.

The following describes the information that must (obligatory fields) or may (optional fields) be
given to fill in the proposal cover sheet.

Preparing and submitting Calibration Proposals with
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5.2.3.1. Title: obligatory field

A short, descriptive title for the observations, as shown in Figure 5.4.

Figure 5.4. An example of a calibration proposal title.

5.2.3.2. Time requested: obligatory field

Should be given in hours to one place of decimals, as shown in Figure 5.5. It is important that this
information is accurate for the inventory of requested calibration time for each instrument and
should coincide with the information in the associated ReadMe file.

Figure 5.5. An example of the time requested to execute a calibration proposal.

5.2.3.3. List of co-Is: optional field

It is expected that this field will rarely, if ever, be required, as calibration proposals will be associ-
ated with an ICC, not an individual and submitted to the HSC operational server from a generic in-
strument account, thus allowing the request for observations to be uniquely associated with a partic-
ular instrument [To be implemented].

Preparing and submitting Calibration Proposals with
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If you need to declare a co-I, for example, a collaborator external to the ICC, click on "Add Co-
Investigators...", as shown in Figure 5.6. Click on "Add..." and fill in the details of the co-I(s) in the
pop-up that appears (Figure 5.7), one by one, clicking on "OK" after each co-I to add their details to
the proposal. You can add as many co-Is as are necessary. [SCR-4270 requests that this option be
suppressed]

Figure 5.6. The pop-up window to fill in co-I details, in the event that it is necessary to declare a co-I for
a calibration proposal. Click on "Add..." to enter details.

Figure 5.7. The details input window. First name, last name, institution and a valid email address are all
required.

The Co-I entry window completed with the details of the co-I (Figure 5.8). [SCR-4270 requests that
this option be suppressed]

Preparing and submitting Calibration Proposals with
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Figure 5.8. The details input window. First name, last name, institution and a valid email address are all
required.

When the details are complete, press "OK" to accept the details and add the name to the co-I list in
the "Co-Investigators" pop-up panel. When all co-Is have been added, press "Done" in this panel to
add the names to the cover sheet information (Figure 5.9).

Figure 5.9. The "Co-Investigators" pop-up panel with a co-I declared. Pressing "Done" transfers this in-
formation to the cover sheet.

When you have accepted the details of all the co-Is and added the names to the cover sheet informa-
tion they will be added the Proposal Submission Tool window and the status of "co-Is" changed
from "Optional" to "Done", as shown in Figure 5.10.

Preparing and submitting Calibration Proposals with
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Figure 5.10. The "Co-Investigators" pop-up panel with a co-I declared. Pressing "Done" transfers this
information to the cover sheet.

5.2.3.4. Abstract: obligatory field

Your proposal abstract should normally contain all necessary details of the observations to be car-
ried out, unless these are so extensive that a PDF file needs to be attached to the proposal. Click on
"Add Proposal Abstract", as shown in Figure 5.11. The Abstract can be typed in, or read from a pre-
viously prepared text file using the "Read from File" option. Please note though that only ACSII text
files can be read in. The abstract should not contain any special symbols, LaTeX characters, or any
other non-standard text (including accented characters) as they are unlikely to reproduce correctly
when the proposal is processed at the HSC and may thus create confusion.

In practice, during Operations, a ReadMe file has been used to transmit the most critical information
and anything that appears here is simply an Aide Memoire for use in processing.

Line breaks are not added when you type directly in the window, thus they must be added by hand
to make the text legible.

Preparing and submitting Calibration Proposals with
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Figure 5.11. The calibration proposal abstract entry window.

There is a hard limit of 2040 characters, including spaces, for the abstract. This translates to about
300-350 words.

When you are satisfied with the Abstract, press the "OK" button (Figure 5.12) to accept it and to add
it to the cover sheet. When you have done this the "Add Proposal Abstract" button will change to
"Modify Proposal Abstract" and the word "Done" will be added in blue to the left to show that the
Abstract has been added correctly to the cover sheet (Figure 5.13). The first 50 characters of the Ab-
stract text will be shown to the left of the button.

Preparing and submitting Calibration Proposals with
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Figure 5.12. A (very abbreviated) calibration proposal abstract.
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Figure 5.13. The Proposal Submission Tool calibration proposal window after adding the abstract text.

5.2.3.5. Proposal PDF: optional field

Unlike normal Herschel proposals a PDF file with the scientific case and technical implementation
is NOT OBLIGATORY. We anticipate that a PDF file will only be required in the case that the re-
quested observations are large in number, or complicated to execute and the ICC deems it necessary
to give additional details to ensure the correct execution of the observations.

Should a PDF be added, there is no requirement to use a special format and there is no need to use
the PDFLaTeX template file used in normal proposals. Ensure that the information given is clear
and concise and separated by sections, as necessary.

If you want to add a PDF file, click on "Add Proposal PDF File" and navegate to the file, as shown
in Figure 5.14. Click on the file to open it and add it to the cover sheet.

Preparing and submitting Calibration Proposals with
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Figure 5.14. Adding a proposal PDF file to a calibration proposal.

5.2.3.6. Add Science Category Information: optional field

Do not use unless specifically requested to. All proposals will automatically considered as Calibra-
tion proposals and will by-pass HOTAC.

5.2.3.7. Add Any Other Text: optional field

Do not use unless specifically requested to. Any additional text that cannot be placed in the ReadMe
should be placed in a PDF file and linked to the proposal.

5.2.4. Reviewing your proposal before submission
At this stage your proposal should look something like Figure 5.15. You should have your AORs
prepared and all the obligatory fields completed in the Proposal Submission Tool.

Figure 5.15. Adding a proposal PDF file to a calibration proposal.

The fields at the bottom of the Proposal Submission Tool window will be blank if this is a new pro-
posal that has not yet been submitted.

At this stage you can make any changes or revisions that are necessary before continuing. Each field
of the Proposal Submission Tool allows you two options to revise your cover sheet information:

• The "Clear" button: Erases all content of that field and resets the field to the left from "Done" to
"optional" or blank.

Preparing and submitting Calibration Proposals with
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• The "Modify" button: Allows you to change the information that has been entered without eras-
ing it.

Similarly, you still have time to modify your AOR(s) before continuing.

When you are convinced that all is well, it is time to press on with the final step.

5.2.5. Submitting the proposal
Click on "Submit" and, in the drop-down menu, select "Submit Proposal to HSC", as shown in Fig-
ure 5.16.

Figure 5.16. The Proposal Submission drop-down menu. For a new proposal, select "Submit Proposal to
HSC".

A pop-up will appear asking you to confirm that the AOR(s) in your Expert HSpot session is/are the
correct ones to submit, as shown in Figure 5.17. If you answer "No" the proposal submission pro-
cess is aborted, although you will stay in the Proposal Submission Tool. In this case you should rec-
tify the problem(s) and then continue with submission.

When you confirm that your AORs are correct, you will be asked to supply a valid Username and
Password to continue with submission, as shown in Figure 5.18.
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Figure 5.17. The Proposal Submission drop-down menu. For a new proposal, select "Submit Proposal to
HSC".

Figure 5.18. The pop-up window to enter your Username and password to authenticate your submission.

Once your Username and password are verified you will be requested to save your coversheet in-
formation to a file, as shown in Figure 5.19. When you do this you will be able to close your Expert
HSpot session and reload your proposal from this file copy. Saving a copy of the proposal to disk is
obligatory to continue. For test proposals you may use the default name but, for genuine submis-
sions you are strongly recommended to give the coversheet an easily recognisable name as this is
your personal record of what you have submitted.

Preparing and submitting Calibration Proposals with
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Figure 5.19. Saving the cover sheet (executive summary) of your proposal. This is your own personal re-
cord of what you submitted, so it is recommended that you give the file a clearly recognisable name.

If the filename for the coversheet already exists Expert HSpot will ask if it is okay to overwrite.
Here you have one last chance to halt submission because, if you say that it is not okay, submission
will be aborted. If the coversheet file name does not exist or you confirm that it is okay to overwrite
the disk the submission process will start. You will not be asked for any further confirmation. Nor-
mally the HSpot cheetah will run for a few seconds to show that the information in your proposal is
being transmitted to the server and, on successful completion of transmission a pop-up will appear,
as shown in Figure 5.20.

Figure 5.20. Saving the cover sheet (executive summary) of your proposal. This is your own personal re-
cord of what you submitted, so it is recommended that you give the file a clearly recognisable name.

This pop-up does not guarantee that your proposal has been received correctly; it only certifies that
the proposal has been transmitted correctly from your local machine to the server. When the propos-
al has been received and processed correctly you will, as the pop-up states, receive an e-mail with
confirmation: this e-mail is the official notification that your proposal has been received correctly.

Preparing and submitting Calibration Proposals with
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On successful completion of transmission you will also see that information on your submission ap-
pears on the bottom line of the Proposal Submission Tool main window, as shown in Figure 5.21,
where the file name, user name and proposal version number (0 for a first submission) will be filled
in on a successful submission.

Figure 5.21. The Proposal Submission Tool window showing the bottom line filled-in with information on
a successful proposal submission.

5.2.6. Reception and processing of calibration propos-
als

Calibration proposals will be submitted by an ICC or by an individual ICS to the local JBOSS server
under the name of the person who has submitted the proposal. From there they will be transferred to
the HSC Operational JBOSS as generic proposals under the name of the instrument (e.g. the first
PACS calibration proposal would have been "Calibration_coppacs_1"). This transfer will be
handled by HSC personel.

In Commisioning Phase all proposals were named Calibration_cop+ (e.g. Calibration_coppacs_10,
Calibration_cophifi_12, etc.) For PV Phase the root name was Calibration_pv+ (e.g. Calibra-
tion_pvpacs_50). An in Routine Phase, it was Calibration_rp+ (e.g. Calibration_rpspire_170).

By convention, even in Routine Phase, engineering AORs or anything that needed a specific calibra-
tion Mission Configuration, was submitted as "Calibration_pv+", with only AORs using a standard
astronomer Mission Configuration submitted as "Calibration_rp+".

Normal operational procedure in Operations was for each ICC to submit a single calibration propos-
al for each period that their instrument was operational. In other words, if PACS was the prime in-
strument for 8 days of a 14 day instrument cycle, a single calibration proposal was submitted to cov-
er the full eight days. This allowed the proposals to be numbered sequentially through the mission
and for the calibration proposal for any cycle during the mission to be readily identifiable.

5.2.6.1. Revising and resubmitting a calibration proposals

Operationally, calibration proposals have often needed to be revised and modified after submission
to take account of unexpected operational circumstances such as the need to repeat observations. To
do this, the proposal should be retrieved from the server, revised and resubmitted. If you have pro-
pHandler privileges, this can be done using the propHandler menu (see Figure 2.5), which allows
you to download and re-submit any proposal in the database.

Otherwise, you have to follow the following procedure to do this.
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Open the Proposal Submission Tool from the "Tools" menu of Expert HSpot and select the "Sub-
mit" menu. Here, you should select the "Retrieve lastest proposal from HSC" option, as shown in
Figure 5.22.

Figure 5.22. Retrieving a proposal from the server. This allows the user to download a previously sub-
mitted calibration proposal and to update it.

When you retrieve a proposal from the server the AORs are also retrieved. A conflict is created if
you have any AORs already present in your session. Expert HSpot will give you a warning if it de-
tects already present AORs and will request you to delete them (Figure 5.23).

Figure 5.23. The warning that Expert HSpot has detected AORs present in your current session when re-
trieving a proposal from the server.

If you have no AORs already loaded, Expert HSpot will connect with the server and return a pull-
down list of proposals for which you have access privileges. Select the proposal that you wish to
modify and resubmit, as shown in Figure 5.24 and Figure 5.25.
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Figure 5.24. Selecting the proposal from the list on the server to download and update it.

Figure 5.25. A selected proposal from the list on the server to download and update it.

When the proposal has been retrieved successfully (this should take only a few seconds) a pop-up
will appear to confirm retrieval Figure 5.26 and the information on the foot of the Proposal Submis-
sion Tool window will update with the User ID of the submitter, the proposal ID and version num-
ber and the name of the saved coversheet file.
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Figure 5.26. A successful proposal retrieval. The information along the bottom of the Proposal Submis-
sion Tool window will update with the details of the proposal.

You may now modify any element of the proposal, as required and update the proposal by selecting
the "Update Proposal at HSC" option (see Figure 5.27).

Figure 5.27. Updating a previously submitted proposal. Select the "Update Proposal at HSC" option in
the "Submit" menu.

You must now save the cover sheet of the proposal, as required and update the proposal by selecting
the "Update Proposal at HSC" option (see Figure 5.28). If you use the same filename to save your
coversheet you will receive an overwrite warning and must confirm that you do wish to overwrite it
(see Figure 5.29).
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Figure 5.28. Updating a previously submitted proposal. Select the "Update Proposal at HSC" option in
the "Submit" menu.

Figure 5.29. Overwrite confirmation when saving the coversheet of your resubmitted proposal. You must
confirm that you wish to overwrite the copy saved to disk with the revised version.

The final stage of resubmission. A confirmation pop-up message will appear that resubmission has
been successful, as shown in Figure 5.30. This will be followed-up by an email confirmation that
your proposal has been received and processed correctly.
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Figure 5.30. Updating a previously submitted proposal. Select the "Update Proposal at HSC" option in
the "Submit" menu.

5.2.6.2. Revising and re-submitting a calibration proposals for
HSC users with propHandler access rights

If you have propHandler rights, you may retrieve and re-submit a calibration proposal from the Pro-
posal Submission Tool. A typical case when this is required is when engineering AORs (for ex-
ample, SEU checks, or cooler re-cycles) have to be cloned for the Mission Planners to ensure that
sufficient are available. To do this, the proposal should be retrieved from the server, revised and re-
submitted. If you have propHandler privileges, this can be done using the propHandler menu (see
Figure 2.5), which allows you to download and re-submit any proposal in the database. Click on it
and select "Retrieve" to load a proposal. After making the necessary mofifications, click on this op-
tion again and select "Submit" to update the proposal in the database.

To do this, you have to know the name of the proposal that you have to update. All active calibra-
tion and engineering proposals are listed on the HSC Twiki at can be found at ht-
tp://herschel.esac.esa.int/twiki/bin/view/HSC/HSCMissionConfig. When re-submitting a proposal,
although you retrieve it with your own userneame and password (to establish your credentials for
access rights), it *MUST* be re-submitted with the same user/password combination used to submit
it so, if you are updating Calibration_pvspire_52 (cooler re-cycles), you must re-submit it with user-
name "pvspire" with the appropriate password for this account. When re-submitting the PACS calib-
ration for schedule Cycle 100 (Calibration_rppacs_199), the proposal *MUST* be submitted with
username "rppacs" and the appropriate password for this account. This is in contrast to the system
for updating science proposals with propHandler access rights where you just use your own user-
name and password to do the update.

Preparing and submitting Calibration Proposals with
Expert HSpot

41

http://herschel.esac.esa.int/twiki/bin/view/HSC/HSCMissionConfig
http://herschel.esac.esa.int/twiki/bin/view/HSC/HSCMissionConfig


Figure 5.31. Updating a previously submitted proposal. Select the "Update Proposal at HSC" option in
the "Submit" menu.
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